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ShapeOut 
 

Software version: 0.7.3 

Instructions version: 1.2 

Copyright: Reproduction and duplication of this document and utilization and communication of 

its content is prohibited, unless with our express permission. 

The software is under constant development, so there might be deviations between the current 

version and the manual. We try to update frequently. 
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Installation of the software 

Download the latest ShapeOut version from Github, following this link: 

http://www.zellmechanik.com/Download.html 

 

Install the software, following the instructions.  

The software is under constant development, so check out for updates from time to time. The 

installer automatically uninstalls older versions of ShapeOut. 
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Folder structure of ShapeIn 

 

[Hard drive]:\Main project folder\YYMMDD_ProjectLeader_ProjectName\SampleName\Offline and 

Online folder. 

Example  

 

The Online folder contains all the measurement files. The file names start with M and a number 

(successive numbering during data acquisition with ShapeIn) M1_....,M2_..., M3_..... 

  

D:\ Experiments\ 160223_Tom_CellLineA\ Control\ Offline 

    Online 

  160311_Eva_PrimCellB\ Control\ Offline 

    Online 

   Test1\ Offline 

    Online 
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Layout of ShapeOut’s main window 

 

 

The menu 

File:  Find Measurements:  

opens a project (including all samples with all measurements) or a single sample 

(including all measurements). Open and choose the “YYMMDD_Project 

Leader_Sample” folder to open a whole project or a “SampleName” folder to open all 

measurements of a sample 

Add Measurement:  

adds another project or sample to the already loaded measurements 

Clear Measurements:  

removes all samples or measurements, which are not selected in the measurement 

browser. 

Save session:  

saves the status of the analysis 

Load session:  

loads a saved session 

Quit:  

quits the program ShapeOut 
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Export: All event data (*.tsv): 

  tool to export datasets (filtered, unfiltered, specified parameters only) 

Graphical plot (*.pdf): 

 exports all plots in a pdf file 

Computed statistics (*.tsv): 

 exports the statistics in a table 

Batch:   Batch analysis of datasets 

Help:   Help functions 

 

Measurement browser and data selector 

The browser shows the opened projects and the corresponding measurements (in an expandable 

tree structure). The name of the measurement is composed of the measurement number, the 

measurement region and the flow rate. For easy selection of measurements, you can use the 

buttons below the browser (e.g. you can select all data for a certain flow rate).  

Analyze button 

The Analyze button plots all selected data either as raw data or using the filter settings.  

 

The tabs 

Information tab 

Shows all saved measurement properties, which are stored in the corresponding *.ini and *.tdms 

files. Several properties are only highlighted if a single measurement is analyzed. If properties 

differ between single measurements this is indicated by “(multiple)”. Use the scroll bars or adjust 

the pane or increase the size of the pane by dragging of the edge to see the full table. 

General 

Cell Number: number of recorded cells. In ShapeIn this number is shown on the front panel 

“Number of cells measured” 
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Channel Width: dimension of the channel. This number is not detected automatically by the 

system, but has to be set by hand in ShapeIn on the front panel under “Channel dimension [µm]” 

Flow Rate: is the sum of sheath and sample flow in µl/s. ShapeIn records this number when the 

measurement starts and shows it on the front panel under “Flow Rate [µl/s]” 

Measurement Number: is the number of the measurement within the opened project. In ShapeIn 

this number is shown on the front panel under “current/next #” 

Region: shows the position of the Region-of-interest during the measurement. This is not 

detected automatically by the system, but has to be set by hand in ShapeIn on the front panel 

under “Region of interest in the …” 

Sample Flow Rate and Sheath Flow Rate: are the flow rates of the sample and sheath flow in µl/s, 

respectively. 

Image 

Cell Aspect Max: gating parameter for maximum aspect ratio = length/height. Here, length defines 

the extension of cell in flow direction and the height the extension of the cell transverse to the 

channel. 

Cell Aspect Min: gating parameter for minimum aspect ratio = length/height. Here, length defines 

the extension of cell in flow direction and the height the extension of the cell transverse to the 

channel. 

Cell Max Height / Length / Min: shows the gate that was set in ShapeIn to exclude cells larger / 

smaller than this number. In ShapeIn these numbers are shown in the normal tab under Gating 

tools. 

Pix Size: resolution of the microscope-camera-system in [µm/pixels]. In ShapeIn this number is 

shown in the expert tab under Expert settings and “Resolution [µm/pix]” 

Thresh: grey value used as a threshold for each pixel of the image after subtracting the 

background image. All pixels above the threshold form the binary image. In ShapeIn under Expert 

settings “min grey threshold”. 

Trig Thresh: minimum number of pixels within the binary image to be further processed in cell 

analysis. In ShapeIn under Expert settings “min pixels threshold”. 

Framerate 
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Frame Rate: of the camera during the measurement. ShapeIn records this information when the 

measurement starts and shows it in the Expert tab under Camera tools and “Framerate [Hz]”. 

ROI 

Height / Width: of the region of interest in pixels. ShapeIn records this information when the 

measurement starts. It is set automatically or manually in the Expert tab under Camera tools and 

“Height [pix]”/ “Width [pix]”. 

Filtering tab 

In this tab, you can filter your data by excluding values beyond certain limits. Select the Enable 

Filters check box on the right and hit the Apply/Reset button to apply/reset the settings. The Box 

Filters limit the range of parameters; the Polygon Filters allow freely defining a gate by a polygon 

in the current plot. The filters are applied to the whole data set, independently of the actual 

shown plot. At least one event has to be within the limits or the program shows an error. 

Box Filters  

Minimum and maximum values for box filters are set to 0.0 by default. As long as min and max 

values equal 0.0, the filter is not applied. On the left of the table the minimum value is set, on the 

right the maximum. If you set a minimum, you have to set a maximum as well, otherwise all data 

points are gated out. 

Range Area: limits the cell size in [µm²]. 

Range Area Ratio: defines the relative difference between convex hull area and cell area (see 

Figure below). “1”: convex hull and area contour are the same, “<1”: forbidden, because the 

convex hull cannot be smaller than the contour. The minimum value is only effective “>1”. 
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Range Aspect: limits the ratio of height and length of the bounding box around the contour of the 

cell (see Figure below).  

 

Range Defo:  limits the deformation 

Range Pos Lat:  limits the lateral position of a contour in the region of interest 

Range Pos x:  limits the position in direction of channel axis in the region of interest 

Range Time: limits a number of time frames within the measurement in [s]. 

Range x-size: limits the size in x direction (width) 

Range y-size: limits the size in y direction (height) 
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Polygon Filters  

See the example procedure for details. 

Statistics tab, Analysis tab, Plotting tab, Scatter plot tab, Contour plot tab are 

explained in the example procedure. 

 

The Plot Window 

 

The plot window contains the plots of single measurements, a plot with an overlay of all contours 

and a legend for the color code of the contour plots. 

The whole panel is a grid of rows and columns, which can be extended or reduced  in the Plotting 

tab. The example above shows three columns and two rows. 
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Example procedure of analyzing 

This chapter shows a general workflow for evaluating data with ShapeOut. As an example, we use 

experimental data acquired with the AcCellerator. On the next pages you will learn the main 

features, but there are many more. Just play around! 

This is the experiment we use as example: 

Day1:  

 one sample, called “Treatment I”, measured at flow rates of 0.04, 0.08 and 0.12 µl/s and 

one measurement in the reservoir 

 one control, called “Control I”, measured at flow rates 0.04, 0.08 and 0.12 µl/s and one 

measurement in the reservoir 

 

Day2:  

 two samples, called “Treatment II” and “Treatment III”, measured at flow rates 0.04, 0.08 

and 0.12 µl/s and one measurement in the reservoir 

 two controls, called “Control II” and “Control III”, measured at flow rates 0.04, 0.08 and 

0.12 µl/s and one measurement in the reservoir 
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Load data 

Download, install and start ShapeOut. (http://www.zellmechanik.com/Download.html)  

 

 

Open the menu File and click Find Measurements. 

 

  

http://www.zellmechanik.com/Download.html
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Select (and do not open) the “YYMMDD_ProjectLeader_ProjectName” folder (here: 

“161224_User_Treatment”) and press the select folder button. 

 

 

The Measurement Browser on the left shows all available measurements from the selected 

folder. 
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Select the datasets you want to analyze (here: all measurements at 0.08 µl/s) by checking the box 

before the measurement name or by using the selection filters which you can find in the lower 

left corner of the screen. 

 

 

Press the Analyze button and wait for the datasets to be loaded. This can take up to several 

minutes depending on the number of events in the dataset. By default the number of events are 

downsampled to 2000 events. You can change this later. 
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Displaying and filtering data 

Go to the Plotting tab and change the Range Area and Range Deformation for best visualization 

of the area of interest in your plots (here: area from 0-400 and deformation from 0-0.25). Press 

Apply. The settings are applied to all plots.  
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Go to the Filtering tab and change the Range Area Ratio to exclude cells with irregular shapes, 

like strong protrusions (here: area ratio between 1-1.05, everything with a higher deviation than 5 

% of the convex hull area compared to the cell area is excluded). Excluded events are shown in 

grey color.

 

Go to the Scatter Plot tab and uncheck the Scatter Plot Excluded Events to show only the filtered 

data. 

 



  

 
 Seite 16 von 41  

Tel + 49 351 41884430 

Fax + 49 351 41884439 

info@zellmechanik.com 

www.zellmechanik.com 

ZELLMECHANIK DRESDEN GmbH 

Tatzberg 47/49 

D-01307 Dresden 

 
 

 

 

Uncheck the Downsampling box to include all events within the filter settings. 
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Change the Scatter Marker Size to adapt the plotted event size to better distinguish single 

events. 

 

 
Go back to the Filtering tab and increase the window by drag & drop of the lower edge of the tab. 
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Polygon filter 

Apply a polygon filter to cut the desired population. Choose the plot where you want to draw the 

filter in the drop down menu under Polygon Filters (here: Control I – M2). 
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Use the mouse pointer and click where a corner-point of the polygon shall appear. The number of 

points is not limited. Adding point by point creates a square in this example. 
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Press Enter to apply the filter. The filter is labeled automatically. The name appears under the 

dropdown menu and is by default checked for all plot. (here: polygon filter 0) 

 

 

If wanted you can uncheck the polygon filter for single plots (here: for Treatment I – M2). 
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Statistics 

Go to the Statistics tab to see all calculated parameters of the filtered data of all plots. 
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Properties of the Contour Plot 

Go to the Contour Plot tab to… 

…change the line color by clicking on the color bar, choosing a color in the color window and 

clicking Apply (here: to red and blue) 

 

…change the way to calculate the Kernel Density, KDE (here: change from Gauss to no calculation)
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...change the resolution of the Contour Plot, by changing Contour Accuracy Area and Contour 

Accuracy Deformation 
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Export data 

Open the Export menu 

 

 

Click on All event data (*.tsv) to open a dialog to choose the data and if you want everything or 

the filtered dataset only. The export function will create a datasheet. Choose a folder to store the 

datasheet.
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Read the data e.g. in Excel. 
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Adding additional data 

Go to the File menu, click Add Measurement and choose the folder of another experiment (here 

161231_User_Treatment) 

 

 
All available data is shown in the measurement browser on the left. 
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Select all measurements you want to compare and click Analyze. (here: all 0.08 µl/s 

measurements are chosen). The filter settings of the previous dataset apply to the new data as 

well. Attention! The color-coding and naming of the contour plots are reset to default. 

 

 
Assign colors and names to the data. (here: red for controls, blue for samples)
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Change the number of visible plots in the plot window 

The window containing all plots, the contour plot and the legend is composed of columns and 

rows. The number of visible columns and rows is static and has to be changed manually to either 

show more or less. Go to the Plotting tab and change the number of rows and columns. (here: 

from 3 columns/ 2 rows to 4 columns/ 2 rows. 
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Save the session 

You can save your work and continue later. Go to the File menu, click Save Session and name the 

session file. The file extension is *.zmso. 
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Change the order of the displayed plots 

Go to the Plotting tab. You can drag&drop the lines in Plot order. (here: all “Control” are moved to 

the top) 

 

Press Apply. Now all “Control” are in the first row. 
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Compare datasets 

Go to the Analysis tab. This tool compares an experiment (control and treatment) and repetitions 

of the experiment. Assign which measurement is a control and which is a treatment by choosing 

the option in the dropdown lists under Interpretation. Group the pairs of control and treatment 

done in one experiment, by choosing an index number, called Repetition. (here: Treatment I and 

Control I are one experiment – called Repetition 1, Treatment II and Control II are a repetition of 

the experiment – called Repetition 2, Treatment III and Control III are another repetition of the 

experiment – called Repetition 3.) 
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Press Apply to start the calculations. A text file will open to show the results. 

 

The most important numbers are: 

Fixed effects 

(Intercept)-Estimate 

is the mean of the parameter 

chosen for all controls. 

treatment-Estimate 

is the effect size of the parameter 

chosen between the mean of all 

controls and the mean of all 

treatments. 

Full coefficient table 

shows the effect size of the 

parameter chosen between 

control and treatment for every 

single experiment 

Model-Pr(>Chisq) 

shows the p-value and the 

significance of the test 
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The mixed model analysis is only applicable if the respective measurements show little difference 

in the reservoir for the parameter chosen. In any other case this information has to be included 

into the model by selecting the reservoir dataset for each measurement. 

 

  



  

 
 Seite 35 von 41  

Tel + 49 351 41884430 

Fax + 49 351 41884439 

info@zellmechanik.com 

www.zellmechanik.com 

ZELLMECHANIK DRESDEN GmbH 

Tatzberg 47/49 

D-01307 Dresden 

Mapping deformation values to Young’s moduli in ShapeOut (Version 

0.7.3) 

 
 
Quick Guide 

 
 
Using ShapeOut, it is now possible to convert deformation values to values of the Young’s 

modulus based on the numerical simulation work for fully elastic spheres by Mokbel et al. 

(1). 

 

You will find a new tab called “Calculate” that allows you to obtain the Young’s modulus 

for the samples you selected for plotting. 

 

 
 

Currently, the only model available is the elastic sphere. After choosing the type of 

measurement medium you must set the right temperature or – in case you choose “Other” 

– the correct viscosity. For CellCarrier media, the correct viscosity is automatically 

calculated according to the shear thinning behavior as analyzed in (2). 
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Once “Compute elastic modulus” is clicked, a plotting option for the Young’s modulus will 

become available. 

  
 

 

It is important to note that a conversion can only be carried out for deformation and size 

values in a “valid region” that will be described in more detail later in this document.  

 

Events outside this region will disappear from the plot – also if the Young’s modulus is 

not selected for plotting. To plot the complete sample in those cases again, the checkbox 

“remove invalid events” in the “Filter” tab needs to be unchecked. 
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Valid Conversion Region 

 

This section is meant to guide an experimental strategy to obtain results that can be 

converted to a Young’s modulus. Numerical simulations (1) have yielded a valid region for 

the conversion in the space of deformation and cell size shown with a color gradient for a 

20 µm channel. 

 
It is limited by regions A and B for objects too small and objects too large for reliable 

conversion. It is further limited for very small deformation values in region C. The reason 

for that is a very steep increase of E with little decrease in deformation that would yield 

potentially very large errors. Finally, it is limited by region D at larger deformation. In this 

region, simulations did not reach a stationary shape for the softer objects to be found 

there. Instead they became more and more elongated until they disintegrated by 

rupturing. 

 

Therefore, as an experimental strategy, the goal of the experiment must be to choose the 

suitable channel size and to vary the flow rate such, that the results fall well within the 

valid region.  

 

In order to make this process more comfortable, in the following, the valid regions are 

shown for the four standard channel sizes available. Those representations include an 

offset shift in deformation that would be expected in the experimental results due to the 

pixelation of the image as described in (2).  
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The values of the Young’s moduli in those regions will depend on the specific flow rate 

and the viscosity of the medium (3). Note that in the illustrations that follow they merely 

represent a relative scaling and are not to be compared between illustrations. 

 
 
For the 15 µm channel: 
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For the 20 µm channel: 

 
 

 

For the 30 µm channel: 
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For the 40 µm channel: 
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